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Introduction to Jaspersoft OLAP
CHAPTER 1 INTRODUCTION TO JASPERSOFT OLAP

The JasperReports Server Community Project builds on JasperReports as a comprehensive family of Business Intelligence 
(BI) products, providing robust static and interactive reporting, report server, and data analysis capabilities. These capabilities 
utilize common metadata and provide shared services, such as security, a repository, and scheduling. The server exposes 
comprehensive public interfaces enabling seamless integration with other applications and the capability to easily add custom 
functionality.

In a nutshell, JasperReports Server provides the ability to:

 Efficiently and securely manage many reports.

 Interact with reports, including entering parameters and drilling on data.

 Schedule reports for distribution via email and storage in the repository.

For business intelligence users, we offer Jaspersoft OLAP, which runs on the server. It is described this user guide. 

Jaspersoft provides several other sources of information to help extend your knowledge of JasperReports Server:

 Our Ultimate Guides document advanced features and configuration. They also include best practice recommendations 
and numerous examples. The guides are available as downloadable PDFs. Community project users can purchase 
individual guides or bundled documentation packs from the Jaspersoft online store. Commercial customers can download 
them freely from the support portal.

 Our free samples, which are installed with JasperReports, iReport, and JasperReports Server, are documented online. 

 JasperForge, our community website, hosts open source projects, associated source code, tools for bug tracking, version 
control, and forums for community discussion. You'll find development and implementation advice, a secure 
development environment for community-driven projects, and community feedback.

1.1 Login

To login to JasperReports Server to access Jaspersoft OLAP:

1. Enter http://hostname:8080/jasperserver in your browser (where hostname is the name of the computer where 
JasperReports Server is installed).

The Jaspersoft Login page appears.
5
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2. To log in, enter your user name and password.

If you installed the sample data, you can use any of the user names and passwords shown, as well as your own. The 
default administrator user is jasperadmin; its password is set to jasperadmin during installation.

3. Under the Login panel, click Show locale & timezone. 

The Locale and Time Zone fields appear.

4. Select your locale and time zone from the drop-down menus.

5. Click Login. 

The repository page appears.

Figure 1-1 Jaspersoft Login Page

Before logging in, you might review the links that appear on the login page.

If the Change password link appears, you can change your password by clicking it.
6
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You can browse the repository using the left-hand panel, search the repository by entering text in the field at the top of the 
page, and select further options from the View and Manage menus.

1.2 External Sources of Information
As analytic practices permeate the business sector, reference books about OLAP and MDX proliferate. While many focus on 
Microsoft SQL Server, the language concepts and syntax apply more broadly. The following resources can help you 
understand analysis:

 Mondrian Technical Guide: http://www.jasperforge.org

 Jaspersoft OLAP Workbench: http://sourceforge.net

 Historical overview of analysis: http://en.wikipedia.org/wiki/analysis

 JPivot SourceForge project: http://jpivot.sourceforge.net/

 William Pearson. MDX at First Glance: Introduction to SQL Server MDX Essentials. http://www.databasejournal.com/
features/mssql/article.php/1495511

 Microsoft MDX reference: http://msdn2.microsoft.com/en-us/library/ms145506.aspx

 Wikipedia MDX overview and links: http://.wikipedia.org/wiki/Multidimensional_Expressions

 A collection of other MDX article links: http: http://msdn2.microsoft.com/en-us/library/ms145506.aspx

 A collection of other MDX article links:http://sqlblog.com/blogs/mosha/archive/2005/10/11/mdx-functions-in-analysis-
services-2005.aspx

 Official XML/A home: http://www.xmla.org/

Figure 1-2 Repository Page
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1.3 Jaspersoft ODBO Connect
Jaspersoft ODBO Connect enables Microsoft Excel Pivot Tables to access Jaspersoft OLAP and other OLAP servers that 
support the XML for Analysis (XML/A) Simple Object Access Protocol (SOAP) protocol. It lets users familiar with Excel 
leverage those skills to explore their OLAP cubes and create pivot tables based on them.

Jaspersoft ODBO Connect is described in its own user guide, which is installed with the product.
8
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CHAPTER 2 WORKING WITH OLAP VIEWS

Jaspersoft OLAP is an On Line Analytical Processing (OLAP ) application. OLAP applications help users analyze and 
understand complex data. Jaspersoft OLAP Community Project uses JPivot for analytical processing with an improved user 
interface.

2.1 Opening an OLAP View
An OLAP view consists of a client connection and an MDX query. A client connection is either a Mondrian connection or an 
XML/A connection; it provides the data that appears in the view. Jaspersoft OLAP contains a number of sample OLAP views. 
For simplicity, this guide assumes you installed the sample data and are logged in as a user with an administrator role (that is, 
that you have access to the view and its data).

To open an OLAP view:

1. Click View > Repository. 

The repository appears. 

2. Scroll through the repository to select an OLAP view or, type the name (or partial name) of the view you want to see in 
the search field at the top of the page.

For example, type in Foodmart or Food.

The repository reappears, displaying the objects that match your text.

The procedures in this document assume that you installed JasperReports Server with its sample data. The schemas 
and views it describes are available only if the samples are installed.
9
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3. To display an OLAP view, right-click it and select Run. For example, right-click Foodmart Sample Analysis View and 
click Run to display the Foodmart sample view. 

Jaspersoft OLAP displays the default view. 

4. Click the tool bar buttons and values in the navigation table to explore the data.

Figure 2-1 Search Results in the Repository

Figure 2-2 Foodmart Sample Analysis View
10
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2.2 Analysis Tool Bar
The tool bar on left side of the view (Figure 2-2 on page 10) provides access to many OLAP operations and features 
described in the following sections. 

2.2.1 Drill into a Dimension Member

2.2.2 Sort Across Hierarchy

2.2.3 Show Empty Rows & Columns

Zoom on Drill Toggles (that is, turns on or off) the zoom in/out hyperlinks for hierarchy members. In the 
following navigation table, Zoom on Drill is selected; All Media and All Products are 
hyperlinks; click them to view the members of their hierarchies.

Sort Across 
Hierarchy

Toggles between sort across and sort within hierarchy. In the following example, Sort Across 
Hierarchy is selected, and the Unit Sales measure is sorted in descending order across the 
Product hierarchy.

Hide Empty 
Rows/
Columns

Hides or reveals rows or columns that do not have relevant fact data. The following example 
includes empty rows for Promotion Media (Street Handout; Sunday Paper; and Sunday 
Paper, Radio, TV.
11
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2.2.4 Swap Axes

2.2.5 Edit Display Option

2.2.5.1 Cube Options

Swap Axes Changes the orientation of the table by switching the columns and rows. In the following 
example, axes for measure columns and dimension rows are switched.

Edit Display 
Options

Allows users to configure the cube options, drill-through options, and sort options, as 
described in the following sections.

Show all parent columns Displays the column headings of a given hierarchy. The following navigation table shows 
Product and Product Family as parent column headings.
12
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2.2.5.2 Drill-through Operations

2.2.5.3 Sort Option

Show individual parent cells Displays each parent member of a given hierarchy. The following navigation table 
displays all parent cells for Promotion Media and Product dimensions.

Include member attributes Displays the member properties of the displayed hierarchy members.

Show table below cube 
(on same page)

Displays the drill-through table below the navigation table. By default, the drill-through table 
appears in a separate browser window.

Hide drill-through links Removes the hyperlinks from the fact data in measures. 

Include only selected 
measure

Limits the display to only the selected measure in the drill-through table.

Sort across cube 
hierarchy

Changes the behavior of sorting across or within dimension hierarchies. See 2.2.2, “Sort 
Across Hierarchy,” on page 11.

Start sorting in 
descending order

Toggles the sort behavior between ascending and descending.

Display only the first N 
rows

Limits the number of rows displayed after sorting.
13
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2.2.6 Show Chart

2.2.7 Edit Chart Options

Show Chart Displays a chart of the navigation table data. The following example shows a bar chart that 
represents the columns in these measures: Unit Sales, Store Cost, and Store Sales.

Edit Chart 
Operations

Defines various charting options.
14
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2.2.8 Change Data Cube

2.2.9 Show MDX Query

Change Data Cube Changes an OLAP view and defines dimension filters. Click Change Data 
Cube to display the options in the following figure.

Columns Selects specific measures to display.

Rows Selects specific dimension members to display.

Filter Selects specific dimension members that don’t appear in the navigation table. 
This selection determines the data displayed in the navigation table.

Show MDX 
Query

Changes the navigation table by editing the MDX query that generates the view. This feature 
is intended for advanced users familiar with MDX and the data structures underlying the view.
15
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2.2.10 Export to Excel

2.2.11 Export to PDF

2.2.12 Edit Output Operations

Export to 
Excel

Prompts you to view or save the current navigation table in Microsoft Excel format.

Export to PDF Prompts you to view or save the current navigation table in Adobe Acrobat PDF format.

Edit Output 
Options

Defines various output options.
16
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2.2.13 Save Buttons

For more information, refer to 2.5, “Saving an OLAP View,” on page 19.

2.3 Navigation Table
The navigation table appears at the top of the OLAP view (Figure 2-2 on page 10). It shows the data that is retrieved by the 
current MDX query, which appears in both the main view and in drill-through tables. 

2.3.1 Expand/Collapse Position

2.3.2 Expand/Collapse Member

Save View Saves this OLAP view. Changes you’ve made since you opened the view are saved to the 
repository. If you don’t have permission to save the view in its current location, the Save 
View As dialog prompts you to select a new location.

Save View As Saves this OLAP view under a new name and location. Changes you’ve made since opening 
the view are saved to the repository in the location you select. Note that you cannot use the 
Save View As button to overwrite an existing view (even if you have sufficient permissions).

Expand 
Position

Expands or collapses rows at a specific hierarchy member. In the following navigation table, 
the All Media member is collapsed: it can be expanded; the All Products member is expanded 
and can be collapsed.

Collapse 
Position

Expand/Collapse 
Member

Synchronizes the expansion or contraction of rows across all hierarchy members when they 
are clicked. The following navigation table shows the Product member expanded for the 
Promotion Media hierarchy member.
17
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2.3.3 Zoom In/Out

2.3.4 Show Source Data (Drill-through)

2.3.5 Expand All/Collapse All

2.3.6 Zoom Out All

Zoom In/Out Click hyperlinked hierarchy members to replace the current table with a sub-table that depicts the 
selected member. The following navigation table shows the table displayed when you zoom in on the 
Drink product of All Products.

Show Source 
Data

Click hyperlinked fact data to display additional columns from that specific fact data. The following 
drill-through table shows the drill-through of Total Unit Sale for Alcoholic Beverages. For more 
information about the drill-through table’s options, refer to 2.4, “Drill-through Table,” on page 19.

Expand All Expands all of the currently displayed members (all those that display the plus sign (+)) to 
the next level of detail in the hierarchies. This can be selected repeatedly to expand all 
levels of detail. This option is only available when Zoom on Drill is not active. This operation 
is limited by the memory available to the application server that hosts JasperReports 
Server. It stops expanding members when this limit is reached.

Collapse All Collapses the navigation table to its initial view.

Zoom Out All Restores the navigation table to its initial view after having zoomed. This option is only 
available when you’re in Zoom on Drill mode. 
18
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2.4 Drill-through Table
The drill-through table displays supporting details for the selected roll-up value in the navigation table (described in 
“Navigation Table” on page 17). The following sections describe the available functionality.

2.4.1 Edit Properties

2.4.2 Output as CSV

2.4.3 Page Controls

By default, the drill-through table opens in its own window. Edit the display options (by clicking ) to display the drill-
through table on the same page as the navigation table. When the drill-through table is on the same page as the navigation 
table, click the small red X in the drill-through table’s upper-right corner to close it.

2.5 Saving an OLAP View
After making changes to the navigation table, save the OLAP view as described in 2.2.13, “Save Buttons,” on page 17. With 
sufficient permissions, you can either overwrite the existing view or save the view with a new name. When you save, you are 
prompted for a name, location, and an optional description. If a view with the same name exists in this location, you are 
prompted to overwrite the existing file. When you save a view with a new name, JasperReports Server displays the new view, 
rather than the view you initially edited. 

Edit Properties Displays at the top-left corner of the drill-through table. Selects the columns to display or 
hide in the drill-through table. The up and down arrows move the columns and specify the 
number of rows to display per page.

Output as CSV Displayed at the top-left corner of the drill-through table. Prompts you to view or save the 
current drill-through table in comma-separated values format.

First, Previous, Next, Last Click the arrows to navigate the pages of data.

Goto Page Enter the number of the page you want to view and press 
return to display the page.

Rows/page Set the number of rows to display.

Jaspersoft OLAP only saves the drill-through table if it is displayed on the same page as the navigation table. For more 
information, refer to 2.2.5.2, “Drill-through Operations,” on page 13.
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CHAPTER 3 JASPERSOFT OLAP ADMINISTRATION

Jaspersoft OLAP administration involves repository management and performance tuning. For information about more 
general administrative tasks, such as access control, see the JasperReports Server Ultimate Guide. 

This chapter includes:

 Overview

 Administering OLAP Views

 Working with OLAP Settings

 Editing a Mondrian Connection

 Editing an XML/A Connection

 Editing a Mondrian Connection

 Editing an OLAP Schema

 Editing a Data Source

 XML/A Configuration

 Logging

 Technical Considerations

3.1 Overview
Jaspersoft OLAP lets you analyze data organized into a hierarchical dimensional model, which has cubes and dimensions as its 
primary entities. In a relational database implementation of online analytical processing (OLAP), the entities reside in 
relational tables. This is sometimes referred to as Relational OLAP (ROLAP). 

Jaspersoft OLAP is based on an open source ROLAP server called Mondrian. JPivot, an open source web-based OLAP user 
interface, enables users to display and navigate Mondrian’s results. Jaspersoft OLAP includeS an improved JPivot user 
interface (as compared to JPivot).

The de facto standard for OLAP query languages is MDX; many analysis applications use it. In a distributed computing 
environment, XML for Analysis (XML/A) is the standard for accessing OLAP data sources remotely. XML/A uses a web 
services architecture, and transmits MDX queries using the SOAP protocol.

The Manage menu, discussed in some of the following sections, only appears if you have an administrative role, such 
as ROLE_ADMINISTRATOR. 
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To implement and maintain Jaspersoft OLAP:

1. Store cube data in a relational database and use an OLAP schema file to define the cubes. Note that using existing 
transactional databases may be inefficient with large amounts of data. To improve performance, use an extract, transform, 
and load (ETL) process: extract information from one or more data sources, integrate and transform the data, and load the 
result into the separate cube database.

2. Identify facts or measures (the values to summarize) and dimensions (divisions of the measures – for example, dividing 
time into weeks, months, and years) in the cube database.

3. Define an OLAP schema, mapping logical facts and dimensions onto the physical database. The Jaspersoft OLAP engine 
uses the schema to interpret the database and perform OLAP queries. The Jaspersoft OLAP Schema Workbench enables 
you to develop, validate, and test schemas against the database. The Mondrian Technical Guide gives details of schemas 
and their options.

4. Create an analysis client connection that includes your schema and a database connection. The repository stores the 
information you provide to define an analysis client connection.

5. Define entry points for analysis of the cube data, known as OLAP views. OLAP views enable end users to interact with 
cubes without having to know query languages, database connections, and other technical details. An OLAP view is an 
MDX query that is run against the cube as a starting point for interactive analysis. OLAP views appear as objects that 
users can select through the web interface. You can use the Jaspersoft OLAP Schema Workbench to develop and test 
MDX queries.

6. Plan for updates to data in the cube, usually on a regular basis (for example, nightly or weekly). After an update, flush 
(empty) the Jaspersoft OLAP data cache, which the server maintains to improve performance, so that subsequent queries 
get the results of new data. For more information, see 3.11, “Technical Considerations,” on page 50.

7. Tune for performance. As a database administrator, analyze the SQL queries that Jaspersoft OLAP issues against the cube 
database. Jaspersoft OLAP has built-in tools that enable you to track queries (for information, refer to 3.11, “Technical 
Considerations,” on page 50). Tune the cube database accordingly with tools specific to the database type (for example, 
indexes and data striping). With large data volumes, you can create pre-calculated tables during the data load (ETL) 
process to aggregate measure values. Jaspersoft OLAP can use the aggregate tables to replace calculations and thus 
improve query performance.

8. Design your environment for scalability and availability. Jaspersoft OLAP can run on a single machine. However, for 
large numbers of users, large data volumes, and high availability, you can use a multi-host environment with load 
balancers and some machines dedicated to either OLAP user interface or OLAP server duties. You can use XML/A to 
distribute processing. For more information, refer to “XML/A Configuration” on page 48.

The detailed procedures, beginning in section 3.2.2, “Creating an OLAP View with a Mondrian Connection,” on page 23, 
step you through the process of setting up all components of an OLAP view.

3.2 Administering OLAP Views
This section describes basic administration of OLAP views, including:

 Overview of an OLAP View

 Creating an OLAP View with a Mondrian Connection

 Creating an OLAP View with an XML/A Connection

 Editing an OLAP View

3.2.1 Overview of an OLAP View

An OLAP view is a collection of multidimensional data that is based on an analysis client connection and an MDX query. It is 
the entry point to analysis operations, such as slice and dice, navigate, and drill-through. Creating a view entails identifying the 
elements that allow Jaspersoft OLAP to retrieve and secure the data.
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3.2.2 Creating an OLAP View with a Mondrian Connection

An OLAP view can retrieve data from a Mondrian connection. For more information on Mondrian connections, refer to 
“Editing a Mondrian Connection” on page 40.

To create an OLAP view with a local Mondrian connection and an MDX query: 

1. Click View > Repository.

The repository page appears. 

2. In the Folders panel, navigate to Analysis Components > Analysis Views.

3. Right-click the folder and select Add Resource > OLAP View.

The Name the View page appears and prompts you to provide a name for the new view. 

4. Enter a name and description for the new view.

5. Click Next.

The Locate Mondrian Client Connection Source page appears and prompts you to select or create a local Mondrian 
connection. 

Figure 3-1 Anatomy of an OLAP View

Figure 3-2 Name the View Page

The Resource ID field is auto-generated from the Name field. After it is saved, it can’t be changed.

MDX Query

Mondrian ConnectionOLAP View

Client Connection *

* Mondrian or XML/A Connection
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6. Click either:

 Define a Mondrian Client Connection in the next step. 

 Select a Mondrian Client Connection from the repository. 

Click Browse, navigate to the connection you want, and click Select. 

Then click Next and skip to step 22.

7. Click Next.

If you choose to define a new Mondrian connection, the Set Connection Type and Properties page appears and prompts 
you to define a connection.

8. To change the type of the connection, select a connection type from the Type drop-down and complete the fields. 
Otherwise, simply change any values as necessary.

To save the connection, click Browse, navigate to select a folder, and then click Select.

Figure 3-3 Locate Mondrian Client Connection Source Page

Figure 3-4 Set Connection Type and Properties Page
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9. Click Next.

The Locate OLAP Schema page appears and prompts you to upload an OLAP schema or select one from the repository.

10. Click either:

 Upload a Local File to select a file from your local computer. 

Then click Browse, navigate to select the file you want, and click Select.

 Select a resource from the Repository to select an existing schema. 

then click Browse, navigate to select the schema, and click Select.

11. Click Next.

The OLAP Schema Resource page appears and prompts you to set the properties of schema. If you choose to upload a 
new file, the fields are editable. Otherwise, skip to step 14.

Figure 3-5 Locate OLAP Schema Page
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12. Provide a name and a description of the schema you are uploading. 

13. Next to the Save Location field, click Browse, navigate to the location where you want to add the file, and then click 
Select. 

14. Click Next.

The Locate Data Source page appears and prompts you to create or select a data source.

Figure 3-6 OLAP Schema Resource Page

If you selected an existing schema in step 10, the fields on this page aren’t editable.
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15. Click either:

 Define a Data Source in the next step to add a data source.

 Data Source from the Repository to select a data source from the repository. 

Click Browse, navigate to the location where you want to add the file, and click Select. 

Click Next and skip to step 22.

16. Click Next.

If you choose to add a new data source, the Set Data Source Type and Properties page appears and prompts you to select a 
datatype and enter the property values.

Figure 3-7 Locate Data Source Page
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17. In the Type field, select the data source type. For example, JDBC Data Source. 

The fields change according to the data source you select to enable you to enter the correct values for this type of data 
source. For more information on creating data source, refer to the JasperReports Server Ultimate Guide.

18. Enter a value in each field as necessary.

19. Click Test Connection to ensure the connection is valid.

A yellow banner at the top of the page displays a message: Connection successful or Connection failed.

20. If the connection test fails, check the values you entered, or check that the data is available from the service you specify, 
and test the connection again.

21. When the test succeeds, click Submit. 

The Define the Query page appears and prompts you for an MDX query string.

Figure 3-8 Set Data Source Type and Properties Page
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22. Enter an MDX query. For example:

select {[Measures].[Unit Sales], [Measures].[Store Cost], [Measures].[Store Sales]} on 
columns, {([Promotion Media].[All Media], [Product].[All Products])} ON rows from Sales 
where ([Time].[2006].[Q4].[12])

23. Click Submit.

If the view passes validation, it is added to the repository. if you receive an error, it is likely that the problem is a typo in 
your query. Carefully review the query to ensure that it is valid.

24. When you have corrected the query, click Submit.

If the view passes validation, it is added to the repository.

3.2.3 Creating an OLAP View with an XML/A Connection

An OLAP view can retrieve data from an XML/A connection. An XML/A connection is a connection to a remote Mondrian 
client connection. For more information on XML/A connections, refer to:

 3.5, “Editing an XML/A Connection,” on page 44 

 3.9, “XML/A Configuration,” on page 48

 3.11.2, “Performance Tuning,” on page 51.

To create an OLAP view with an XML/A connection:

1. Click View > Repository.

The repository appears.

2. In the Folder panel, navigate to Analysis Components > Analysis Views.

3. Right-click the Analysis Views folder and select Add Resource > OLAP View from the context menu.

The Name the View page appears and prompts you to enter the basic details about the new view.

Figure 3-9 Define the Query Page
29



Jaspersoft OLAP User Guide
4. Enter a name and a description of the view and click Next.

The Locate Mondrian Connection page appears.

5. In the Connection Type drop-down, select XML/A Connection.

6. Click either:

 Define a XML/A Client Connection in the next step to add a new connection.

 Select a XML/A Client Connection from the Repository to select a data source from the repository. 

Click Browse, navigate to the location where you want to add the file, and click Select. 

Click Next and skip to step 9.

If you choose to create a new client connection, the Set Connection Type and Properties page appears and prompts you to 
enter details about the connection.

Figure 3-10 Name the View Page
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7. Complete the fields:

 General details include the name, label, and description of the connection.

 Data options include the catalog, data source, and URI of the data that this connection should return. These details 
describe a data store in your remote XML/A provider.

 Credentials are the name and password Jaspersoft OLAP can pass to the remote XML/A provider to log in. If this 
user’s password changes, the connection will fail. You can leave the User Name and Password fields blank, so the 
logged in user’s credentials are passed to the remote server when the connection is accessed.

8. Click Next.

The Define the Query page appears and prompts you for a query string.

Figure 3-11 Set Connection Type and Properties - XML/A Page

Your XML/A provider may be another JasperReports Server instance hosting Mondrian connections. For more 
information, refer to section 3.9, “XML/A Configuration,” on page 48.
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9. In the Query String field, enter the MDX query. For example:

select {[Measures].[Unit Sales], [Measures].[Store Cost], [Measures].[Store Sales]} on 
columns, {([Promotion Media].[All Media], [Product].[All Products])} ON rows from Sales 
where ([Time].[2006].[Q4].[12])

10. Click Submit.

If the view passes validation, it is added to the repository. if you receive an error, it is likely that the problem is a typo in 
your query. Carefully review the query to ensure that it is valid.

11. When you have corrected the query, click Submit.

If the view passes validation, it is added to the repository.

3.2.4 Editing an OLAP View

To change the naming, connection, or MDX query in an OLAP view:

1. In the Search field in the repository, enter the name (or partial name) of the OLAP view you want to edit, and click the 
Search icon.

For example, enter food.

The repository appears, displaying the objects that match the text you enter.

2. Right-click the view you want and click Edit.

The Name the View page appears with the fields populated.

Figure 3-12 Define the Query Page
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3. Make your changes to the fields as necessary and then click Next.

The page that appears depends on the type of client connection defined in the view. For example, if the view specifies a 
Mondrian connection the Locate a Mondrian Connection Source page appears.

4. Depending on the type of connection specified, enter values as necessary. Click each field you want to change and enter 
new values.

See “Creating an OLAP View with a Mondrian Connection” on page 23 and 3.2.3, “Creating an OLAP View with 
an XML/A Connection,” on page 29.

5. Click Next.

The Define a Query page appears with the query language set to MDX.

Figure 3-13 Name the View

Figure 3-14 Locate Mondrian Client Connection Source
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6. Change the query or enter a new one, if necessary.

7. Click Submit.

If the view passes validation, it is added to the repository. If you receive an error, it is likely that the problem is a typo in 
your query. Carefully review the query to ensure that it is valid.

8. When you have corrected the query, click Submit.

If the view passes validation, it is added to the repository.

3.3 Working with OLAP Settings
Various configurable properties control the OLAP engine behavior. In most cases, you can use the default values for these 
properties. However, if you want to adjust the performance, you may need to change them. 

3.3.1 Changing OLAP Settings

To change the OLAP settings:

1. Click Manage > OLAP Settings.

The OLAP Settings page appears.

Figure 3-15 Define the Query

You can also edit a view’s MDX query by modifying the navigation table and saving the view.

You must be logged in as a user with the ROLE_ADMINISTRATOR role to access and change OLAP settings.
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Note that the name of each property (as it appears in the underlying OLAP engine) is shown. The properties are described 
in the table below.

2. Review the available properties described below to determine if they can be changed to improve performance.

3. On the JasperReports Server host, locate the mondrian.properties file. It resides in the WEB-INF directory in your 
JasperReports Server installation.

4. Open the mondrian.properties file and locate the property you want to change. 

5. Adjust the value to the right of the equals sign to change the property, save the file, and restart JasperServer.

Test your views and adjust properties as your findings dictate. 

The properties have the following meanings:

Figure 3-16 OLAP Settings Page

To log the SQL queries Jaspersoft OLAP sends to the database, set the Generate Formatted SQL Traces 
option. This ensures that Jaspersoft OLAP writes the SQL queries it executes to the log file you specify.

Property Notes

General Behavior

Performance Profiling Enabled When enabled, performance profiling data is generated and recorded.

Disable OLAP Memory Caching Turns off caching completely. Disabling caching can have a very noticeable 
negative performance impact.

Generate Formatted SQL Traces When tracing is enabled, Jaspersoft OLAP formats SQL queries in the trace 
output with line breaks, which makes them easier to read.

Query Limit The maximum number of concurrent queries allowed.

Result Limit When set to a number greater than 0, result sets are limited to the specified 
number of rows.

Maximum number of passes 
allowable while evaluating a MDX 
expression

When evaluating an MDX query, the maximum number of passes allowed. 
Jaspersoft OLAP returns an error when this threshold is exceeded; for 
example, the error may occur during complex calculations.
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Class name of ExpCompiler to use If entered, this must be a Java class name that is an implementation of the 
mondrian.calc. ExpCompiler interface. Refer to the Mondrian Javadoc for 
more information. 

MDX identifiers are case-sensitive Specifies whether the MDX parser considers the case of identifiers.

Sibling members are ordered 
according to their ordinal expression 

Specifies whether siblings at the same level of a dimension are compared 
according to the order key value retrieved from their ordinal expression. By 
default, ordinal expressions are only used for ORDER BY, and Jaspersoft 
OLAP ignores the actual values. When this property is enabled, Jaspersoft 
OLAP can correctly order members when native filtering is used. Note that 
this setting requires that the RDBMS provides non-null instances of 
java.lang.Comparable that yield the correct ordering when calling their 
Comparable.compareTo method. 

If > 0, Maximum query time (secs) When set to a value greater than zero, Jaspersoft OLAP times out if the 
query takes longer than the specified number of seconds. If a query exceeds 
the limit, Jaspersoft OLAP returns an error.

For more information, refer to the Query Limit and Result Limit entries in this 
table.

Number of elements read when 
processing high cardinality 
dimension elements

This property determines how many members Mondrian reads in one block 
from the database. Setting large values for this property increases 
performance but can overload memory. Values should be prime with 
mondrian.result.limit.

For more information, refer to the Mondrian Technical Guide.

Sparse Segment Density Threshold Performance tuning variable. This property only applies when 
SparseSegmentCountThreshold is enabled. It determines whether to use a 
sparse or a dense representation when collections of cell values are stored in 
memory.

Sparse Segment Count Threshold Performance tuning variable. this property only applies when 
SparseSegmentDensityThreshold is set. It determines whether a sparse or a 
dense representation is used when collections of cell values are stored in 
memory.

When storing collections of cell values, Jaspersoft OLAP can use either a 
sparse or a dense representation. This is determined by the possible and 
actual number of values: density is calculated as actual / possible.

Whenever possible, Jaspersoft OLAP uses a sparse representation - 
countThreshold * actual > densityThreshold.

For example, for the default values (countThreshold = 1000, 
SparseSegmentDensityThreshold = 0.5), Jaspersoft OLAP uses a dense 
representation for:

♦1000 possible, 0 actual, or

♦2000 possible, 500 actual, or

♦3000 possible, 1000 actual)

If there are fewer actual values or more possible values, Jaspersoft OLAP 
uses a sparse representation.

During schema load, invalid 
members are ignored and will be 
treated as a null 

When enabled, Jaspersoft OLAP ignores invalid members during schema 
load; they are treated as null members if they are referenced in a later query.

During query validation, invalid 
members are ignored and will be 
treated as a null

When enabled, Jaspersoft OLAP ignores invalid members during query 
validation; invalid members are ignored and are treated as null members.

Property, continued Notes
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Defines how a null Member is 
represented in the result output

Specifies how Jaspersoft OLAP should represent a null member in the result 
output. 

If > 0, the maximum number of 
iterations allowed when evaluating 
an aggregate

When set to a number greater than 0, the maximum number of iterations 
allowed when evaluating an aggregate. When set to 0, iterations are 
unlimited.

If a query exceeds the limit, Jaspersoft OLAP returns an error that specifies 
this property’s value. For more information, refer to the Query Limit and 
Result Limit entries in this table.

If > 0, crossjoin result limit beyond 
which the optimizer will be applied

When set to a number greater than 0, a threshold for a crossjoin input list's 
size; if it exceeds this value, and the axis has the NON EMPTY qualifier, 
Jaspersoft OLAP uses the non-empty optimizer.

When this property is set to 0, Jaspersoft OLAP applies the non-empty 
optimizer to all crossjoin input lists. To ensure that the optimizer is never 
applied to crossjoin input lists, set this value to the Integer.MAX_VALUE. 

If there are unrelated dimensions to a 
measure in context during 
aggregation, the measure is ignored 
in the evaluation context

When dimensions unrelated to a measure are detected during aggregation, 
the measure is ignored in the evaluation context. Note that this property can 
only affects measures whose CubeUsage’s 
IgnoreUnrelatedDimensions is false.

For more information, refer to the Mondrian Technical Guide, which is 
available at http://www.jasperforge.org.

Do elements of a dimension (levels, 
hierarchies, members) need to be 
prefixed with dimension name in the 
MDX query

Determines if elements of dimension (levels, hierarchies, and members) 
must be prefixed with the dimension name in MDX queries. 

this property determines whether certain queries succeed or fail based on the 
way the dimension elements are defined in the MDX query. When this 
property is enabled, this query fails:

select {[Omaha]} on columns from cust

When this property is disabled, that same query succeeds.

With the property enabled, the correct query is:

select {[Nebraska].[Omaha]} on columns from cust

If your schema is very large or complex, Jaspersoft recommends enabling 
this setting, as processing such schemas can be very resource-intensive. 

For more information, refer to the Mondrian Technical Guide, which is 
available at http://www.jasperforge.org.

Division by null or zero produces 
NULL

By default, when Jaspersoft OLAP attempts to divide by zero or null, it 
evaluates to Infinity, which is correct for some analysis providers. When this 
property is enabled, Jaspersoft OLAP instead evaluates such calculations to 
null, which can be helpful in certain circumstances.

Solve Order evaluation behavior Specifies how to evaluate the SOLVE_ORDER:

 Absolute. Any specified scope is ignored and the SOLVE_ORDER value is 
absolute. For example, Jaspersoft OLAP gives precedence to a query-
defined calculated member with a SOLVE_ORDER of 1 over a cube defined 
value of 2.

 Scoped. Jaspersoft OLAP first resolves cube-calculated members, then 
resolves session-scoped members, and finally resolves query-defined 
calculations. Jaspersoft OLAP only applies the SOLVE_ORDER value within 
the scope in which it was defined.

Property, continued Notes
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Aggregate Settings

Enable Aggregate Tables When enabled, Jaspersoft OLAP identifies tables in the database that are 
aggregates, and uses those aggregate values.
For more information, refer to the Mondrian Technical Guide, which is 

available at http://www.jasperforge.org.

Choose Aggregate Table By Volume Performance tuning variable for aggregates. This property only applies when 
aggregate tables are used. Consider using this property when optimizing for 
tables with many large columns. this property determines whether aggregate 
tables are ordered by volume or row count. 
When this property is enabled, Jaspersoft OLAP uses the aggregate table 
with the smallest volume (number of rows multiplied by number of columns); 
when it is disabled, Jaspersoft OLAP uses the aggregate table with the 
fewest rows.

Optimize predicates Determines whether Jaspersoft OLAP optimizes predicates. When this 
property is enabled, Jaspersoft OLAP optimizes certain predicates.

When it is disabled, predicates are only optimized when all of a dimension’s 
members are included. In this case, Jaspersoft OLAP only retrieves the data 
specified in the query.

For more information, refer to the Mondrian Technical Guide, which is 
available at http://www.jasperforge.org.

Rule file for aggregate table 
identification

Specifies a file that defines aggregate table recognition rules. This file can 
either reside in the application server or the file system. Typically, you can 
accept the default.

AggRule element's tag value The AggRule element's tag value. Typically, you can accept the default.

Print SQL to log for aggregate table 
creation to support MDX with 
aggregates

Determines whether Jaspersoft OLAP prints the SQL code generated for 
aggregate tables.

When this property is enabled, Jaspersoft OLAP processes each aggregate 
request and prints both the lost and collapsed dimension create and 
insert SQL statements. When used in conduction with the CmdRunner, it 
lets you automatically create aggregate table generation SQL.

Factory class for determining the 
tables and columns of a data source

If entered, this must be a Java class name that is an implementation of the 
mondrian.rolap.aggmatcher.JdbcSchema.Factory interface. The default 
implementation is mondrian.rolap.aggmatcher.JdbcSchema.StdFactory. 
Refer to the Mondrian Javadoc for more information.

Cache and SQL Settings

Use a cache for the results of 
frequently evaluated expressions

Determines whether Jaspersoft OLAP caches the results of frequently-
evaluated expressions. Enabling this property can reduce the number of 
unnecessary computations when processing a large amount of data. 

Cache RolapCubeMember objects Determines whether Jaspersoft OLAP caches RolapCubeMember objects, 
which each associate a member of a shared hierarchy with a cube that uses 
it.

Disable this property if you plan to use the member cache control.

Property, continued Notes
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Maximum number of constraints in a 
single `IN' SQL clause

The maximum number of constraints in a single SQL IN clause. This value 
varies with your RDBMS type and configuration. Jaspersoft recommends 
these values:

 MySQL: 10,000

 Oracle: 1,000

 DB2: 2,500

 Other: 10,000

Some NON EMPTY CrossJoin MDX 
statements will be computed in the 
database

When enabled, Jaspersoft OLAP pushes down to the database processing 
related to some NON EMPTY CrossJoin MDX statements.

Some TopCount MDX statements will 
be computed in the database

When enabled, Jaspersoft OLAP pushes down to the database processing 
related to some TopCount MDX statements.

Some Filter() MDX statements will be 
computed in the database

When enabled, Jaspersoft OLAP pushes down to the database processing 
related to some Filter() MDX statements.

Some NON EMPTY MDX statements 
will be computed in the database

When enabled, Jaspersoft OLAP pushes down to the database processing 
related to some NON EMPTY MDX set operations (Such as 
member.children, level.members and member.descendants).

Expand non native sub-expressions 
of a native expression into 
MemberLists

When enabled, Jaspersoft OLAP expands non-native sub-expressions of a 
native expression into MemberLists.

Alerting action in case native 
evaluation of a function is enabled 
but not supported in a particular 
query

Specifies the error level (OFF, WARN, or ERROR) to use when a function’s 
native evaluation is enabled but isn’t supported in the context of a particular 
query's usage. Errors are only returned in the case of a NonEmptyCrossJoin.

Alerts are only raised when there is a possibility that native evaluation would 
improve matters.

Some rollup queries will be 
combined using group by grouping 
sets if the SQL dialect allows it

When enabled, Jaspersoft OLAP combines some rollup queries using group 
by grouping sets. Note that this property only applies to data stored in 
Oracle, DB2, or Teradata.

XML/A Settings

XML/A Maximum Drill Through Rows Limits the number of rows returned from an XML/A drill-through operation.

First row in the result of an XML/A 
drill-through request will be filled 
with the total count of rows

If this property is enabled, the first row returned for an XML/A drill-through 
request shows the total count of rows in the underlying database.

Memory Monitoring Settings

Use Java 5 Memory monitoring to 
avoid out of memory

When enabled, and you use JVM 1.5 or later, Jaspersoft OLAP uses the 
Java5 memory monitoring capability. In this case, when memory is 
exhausted, Jaspersoft OLAP returns a MemoryLimitExceededException 
exception rather than an out of memory error.

Threshold to limit memory used Specifies the percent of memory usage that should trigger a notification to 
Jaspersoft OLAP that memory is low.

Class name of factory to manage 
memory

If entered, this must be a Java class name that is an implementation of the 
mondrian.util.MemoryMonitor interface. Such a class 
(mondrian.util.NotificationMemoryMonitor). Refer to the Mondrian Javadoc 
for more information.

Property, continued Notes
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3.3.2 Flushing the OLAP Cache

This option clears the in-memory cache that Mondrian builds; caching is used to improve query performance. Flushing the 
cache is not usually necessary except when underlying data in the database changes. For example, after running an ETL 
process, the cache is out of date; it may not match the data in the database. 

Such data changes are not reflected in OLAP views until the application server is restarted or until the cache is flushed.

To flush the cache, click Manage > OLAP Settings and click Flush OLAP Cache near the top of the page.

The OLAP cache is also automatically flushed when an existing Mondrian connection or one of its components (such as the 
schema or data source) is changed in the repository.

3.4 Editing a Mondrian Connection
You can change the connection name, the schema, and data source in a Mondrian connection.

To edit a Mondrian connection:

1. In the Search field, enter the name (or partial name) of the Mondrian connection you want to edit, and click the Search 
icon. For example, enter foodmart.

The repository appears and displays objects that match the text you entered.

To narrow the search, you can select the type of report, the time and date the report was created, and other attributes in the 
Filters panel. For example, to view reports that was changed by anyone, click Changed by anyone in the Filter panel. 

2. Right-click the Mondrian connection you want to edit and click Edit.

The Set Connection Type and Properties page appears with the fields populated.

Figure 3-17 Anatomy of a Mondrian Connection

OLAP Schema *

Mondrian ConnectionMondrian Connection

JNDI/JDBC Data Source

* Metadata: XML file in repository
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3. Change values as necessary and click Next.

The Locate OLAP Schema page appears.

You can either accept the existing file or replace it. If you replace the file, you can either upload a new file or select one 
from the repository.

4. To accept the existing file, click Next.

5. To replace the file, either:

 Click Upload a Local File and click Browse to upload a new schema from your local computer.

 Click Select a resource from the Repository, click Browse, and navigate the repository to the schema you want to 
use. Then click Select.

6. Click Next.

The OLAP Schema Resource page appears.

Figure 3-18 Set Connection Type and Properties

Figure 3-19 Locate OLAP Schema
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7. If you choose to upload a new file, enter a name and description for it.

If you accepted the existing file or selected one from the repository, the fields aren’t editable.

8. Click Next.

The Locate Data Source page appears.

You can either accept the existing data source or replace it. If you replace it, you can either define a new data source or 
select one from the repository.

9. To accept the existing data source, click Next.

Figure 3-20 OLAP Schema Resource

Figure 3-21 Locate the Data Source
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10. To replace the data source, either:

 Click Define a Data Source in the next step.

 Click Select a Data Source from the Repository, click Browse, and navigate the repository to locate the data 
source you want to use. Then click Select. 

11. Click Next.

If you accepted the existing data source, or if you selected a data source from the repository, the connection is saved to the 
repository.

If you choose to define a new data source, the Set Data Source Type and Properties page appears. 

12. Select a data source to from the Type drop-down and specify the details in each field. For more information on defining 
data sources, refer to 3.8, “Editing a Data Source,” on page 46

13. Click Submit.

The updated connection appears in the repository.

Figure 3-22 Set Data Source Type and Properties

Be sure to test the new connection to ensure it works properly.
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3.5 Editing an XML/A Connection

To edit an XML/A connection’s naming and connection properties:

1. In the Search field, enter the name (or partial name) of the connection you want to edit, and click the Search icon. For 
example, enter sugar.

The search results appear, displaying objects that match the text you entered.

2. Right-click the XML/A connection you want to change and click Edit.

The Set Connection Type and Properties page appears.

3. Make changes as necessary. 

Figure 3-23 Anatomy of an XML/A Connection

Figure 3-24 Set Connection Type and Properties

XML/A Connection

XML/A Data Source *

* In XML/A Server

Catalog Name *

User Credentials (Optional)URL to XML/A Server
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Jaspersoft recommends caution if you change the type of the connection, as you can’t edit the name or description of the 
connection in this view..

4. Click Submit.

The edited XML/A Connection appears in the repository.

3.6 Creating an OLAP Schema
You can upload an OLAP schema to the repository so that it can be accessed by more than one Mondrian connection. Doing 
this before creating a view simplifies the procedure for defining Mondrian connections and OLAP views.

To create a schema: 

1. Click View > Repository.

The repository appears.

2. In the Folder panel, navigate to Analysis Components > Analysis Schemas. 

3. Right-click the folder and navigate to Add Resource > File > OLAP Schema.

The Upload a File From Your Local Computer page appears and prompts you to select a file and set its properties. 

4. Next to the Path to File field, click Browse and locate the OLAP schema you want to add.

5. Enter a name and description for the schema.

The Resource ID is auto-generated as you type in the Name field. You can change the ID if necessary.

6. Next to the Save Location field, click Browse and navigate to the location in the repository where you want the file to 
reside.

7. Click Submit. 

The new file appears in the repository.

If you specify an instance of JasperReports Server as your XML/A provider (in the URI field), and it hosts more 
than one organization, specify the organization name in the User Name field, separated from the account name 
with the pipe character (|). For example, to connect as a user named joesuer in an organization named 
organization_1, specify joeuser|organization_1 in the User Name field.

Figure 3-25 Upload a File From Your Local Computer
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3.7 Editing an OLAP Schema

To change an OLAP schema’s naming and file source:

1. In the Search field, enter the name (or partial name) of the schema you want to edit, and click the Search icon. For 
example, enter sugar.

The search results appear, displaying objects that match the text you entered.

2. Select the schema, right-click, and then click Edit.

The Upload a File From Your Local Computer page appears and prompts you to the values.

3. To upload a new file, next to the Path to File field, click Browse and navigate to the file you want to upload.

4. Enter changes to the Name and Description fields as necessary.

5. Next to the Save Location field, click Browse and navigate to the location where you want to store the file, and click 
Select.

6. Click Submit.

The edited schema appears in the repository.

3.8 Editing a Data Source 

To change a data source’s properties:

1. In the Search field, enter the name (or partial name) of the object you want to edit, and click the Search icon. For 
example, enter sugar.

The search results display objects that match the text you entered.

2. Right-click the data source and click Edit from the context-menu. 

The Set Data Source Type and Properties page appears.

You cannot change the Type field or the Resource ID field.

Figure 3-26 Upload a File From Your Local Computer Page
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3. Change the values as necessary and then click Test Connection. 

4. If the test fails, check the values you entered and ensure that the system the data source points to is available.

5. When the test is successful, click Submit.

Figure 3-27 Set Data Source Type and Properties

Different options appear, depending on the type of data source (JDBC, JNDI, or Bean by default). For more 
information, refer to the JasperReports Server Ultimate Guide.
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3.9 XML/A Configuration
XML/A connections point to Mondrian connections in remote XML/A providers, allowing you to separate your front end 
processing from your back end processing when analyzing data in OLAP views.

Jaspersoft OLAP can run as a XML/A server, allowing OLAP queries to be run from remote clients and query results returned 
to those clients over the XML/A web services protocol. The OLAP data for XML/A comes from Mondrian Connections.

Jaspersoft OLAP XML/A connections (Shown in Figure 3-28 on page 48, which were defined above, provide a client view to 
XML/A servers, including Jaspersoft OLAP. You may want to run separate Jaspersoft OLAP servers, splitting the Jaspersoft 
OLAP XML/A clients from the XML/A servers. This client/server configuration allows load balancing, 24/7 availability, and 
fail over in Jaspersoft OLAP environments. Other clients that can connect to Jaspersoft OLAP running as a XML/A server 
include Excel Pivot Tables with the Jaspersoft ODBO Driver.

In order to allow Jaspersoft OLAP to run as a XML/A server, XML/A sources need to be defined in the repository. The list of 
XML/A sources a given client can connect to can be controlled by repository permissions, as XML/A clients must authenticate 
via user name and password, and their access to the repository can be limited by permissions. In Jaspersoft OLAP Professional 
and Enterprise, OLAP data level security can be used to filter OLAP query results based on the logged in user making the 
XML/A requests.

3.9.1 Creating an XML/A Source

An XML/A source defines a single OLAP data source that can be used by an XML/A client. The Catalog name uniquely 
defines the data source for the XML/A client. The XML/A source defines a particular Mondrian connection in the repository 
that will answer OLAP query requests.

To add an XML/A source:

1. Click View > Repository.

2. In the Folder panel, navigate to Analysis Components > xml/a. 

3. Right-click xmla and select Add Resource > Mondrian XML/A Source from the context-menu.

The Set Mondrian XML/A Source Properties page appears and prompts you to enter basic information.

Figure 3-28 Anatomy of an XML/A Source

XML/A Source

Mondrian ConnectionCatalog Name (for clients)
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.

4. Enter XML/A source information. For example:

5. Click Submit to save the XML/A source.

Once you create an XML/A source in and XML/A provider such as Jaspersoft OLAP, you must create an XML/A 
connection in your client application that points to it. For more information, see 3.11.2, “Performance Tuning,” on 
page 51.

3.9.2 Editing an XML/A Source

You can change an XML/A source name and connection properties. 

To edit an XML/A source:

1. In the Search field, enter the name (or partial name) of the schema you want to edit, and click the Search icon. 

For example, enter sugar.

The search results appear, displaying objects that match the text you entered.

2. Right-click an XML/A source, and click Edit on the context-menu.

The Set Data Source Type and Properties page appears.

Figure 3-29 Set Mondrian XML/A Source Properties

Name SugarCrmMondrianXmlaSource

Resource ID Sugar CRM Mondrian XML/A Source

Description Sugar CRM Mondrian XML/A Source

Catalog The name of the database that contains the data to analyze.

Mondrian Connection Reference The path and name of the connection this XML/A source 
references. If the XML/A provider is JasperReports Server, its 
value is the connection’s URI.
49



Jaspersoft OLAP User Guide
3. Click each active field you want to change and enter the new data.

4. Click Submit.

The updated source appears in the repository.

3.10 Logging
Jaspersoft OLAP logging is controlled through log4j settings. log4j’s statement logging occurs in the mondrian.mdx and 
mondrian.sql log4j categories. These categories log the statements and how long execution ran. The SQL log also records 
the number of results returned in the result set.

To log your MDX and SQL queries, edit the /WEB-INF/log4j.properties file and uncomment these lines:

To log all possible Mondrian debugging information, add this line to the log4j.properties file:

Adding this property also ensures that Jaspersoft OLAP logs all SQL and MDX queries.

To log the SQL generated when users drill-through to the underlying transactional data, add this line to the log4j.properties 
file:

3.11 Technical Considerations

3.11.1 XML/A Security

The default configuration uses HTTP Basic authentication to challenge requests for the /xmla path. If the client doesn’t have a 
valid JasperReports Server user name and password in its XML/A connection source, the connection will fail, unless the user 

Figure 3-30 Set Data Source Type and Properties

#log4j.logger.mondrian.mdx=debug, jasperanalysis 

#log4j.logger.mondrian.sql=debug, jasperanalysis

log4j.logger.mondrian=debug

log4j.logger.jasperanalysis.drillthroughSQL=DEBUG,jasperanalysis
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name and password are left blank; in this case, the credentials of the logged in user are passed by the client application to the 
remote server. 

When creating an XML/A connection, you can either specify a user name and password for all users to share, or you can leave 
user name and password blank, so that the connection passes the current user’s name and password to the server.

3.11.2 Performance Tuning

For a simple application with a relatively small dataset for which performance is not critical, (for example, a small intranet 
application or developer environment), the simplest server configuration is to run a single application server that connects to a 
local database, which contains both the data being analyzed (that is, the operational data store) and the JasperReports Server 
repository database. However, this configuration doesn’t perform under a large load. This section describes steps you can take 
to improve performance for larger implementations and data sets.

For larger analysis applications, the ROLAP database is often a performance bottleneck. In this case, dedicate a computer to 
host the ROLAP database, and configure JasperReports Server to access it. The database and its host should be optimized for 
disk read and write. This separation of the application from the data is sufficient for many implementations.

To improve performance further, separate the Jaspersoft OLAP user interface from other elements. Inside Jaspersoft OLAP, 
the application that visualizes your results and provides navigation (JPivot) competes for resources with the analysis engine 
(Mondrian). To separate these processing resources, run two different instances of Jaspersoft OLAP: one that handles JPivot’s 
tasks, and another that handles Mondrian’s. The former instances is called the XML/A client; the latter is called the XML/A 
provider (or XML/A server). In the XML/A provider, define Mondrian connections that point to your operational data store. 
Then define XML/A connections in the XML/A client that point to Mondrian connections in the 
XML/A provider.

In this configuration, your users connect to the XML/A client, which sends XML/A requests to the XML/A provider, which in 
turn connects to the database (using a Mondrian connection) to retrieve the results; it returns the results to the XML/A client. 
The XML/A client then provides visualization and navigation for your end users.

In this configuration, Mondrian and JPivot don’t compete for resources, and performance in large implementations is 
improved. For more information, see 3.9, “XML/A Configuration,” on page 48.

With HTTP Basic authentication, clear-text passwords are transmitted in the header of an HTTP request unless you 
have enabled JasperReports Server to use encrypted passwords. 
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Ad Hoc Editor

The interactive report designer in JasperReports Server Professional and Enterprise editions. Starting from a collection of 
fields predefined in a Topic or selected from a Domain, the Ad Hoc Editor lets you drag and drop report elements to draft, 
preview, and finalize reports. Like JRXML reports, Ad Hoc reports can be run, printed, and scheduled within JasperReports 
Server. In addition, Ad Hoc reports may be reopened in the Ad Hoc Editor, further modified, and saved.

Analysis Client Connection

A definition for retrieving an analysis view. An analysis client connection is either a direct Java connection (Mondrian 
connection) or an XML-based API connection (XML/A connection).

Analysis Schema

A metadata definition of a multidimensional database. In Jaspersoft OLAP, schemas are stored in the repository as XML file 
resources.

Analysis View

A view of multidimensional data that is based on an analysis client connection and an MDX query. It is the entry point to 
analysis operations, such as slice and dice, drill down, and drill through.

Audit Archiving

To prevent audit logs from growing too large to be easily accessed, the system installer configures JasperReports Server to 
move current audit logs to an archive after a certain number of days, and to delete logs in the archive after a certain age. The 
archive is another table in the JasperReports Server’s private database.

Audit Domains

A Domain that accesses audit data in the repository and lets administrators create Ad Hoc reports of server activity. There is 
one Domain for current audit logs and one for archived logs.

Audit Logging

When auditing is enabled, audit logging is the active recording of who used JasperReports Server to do what when. The 
system installer can configure what activities to log, the amount of detail gathered, and when to archive the data. Audit logs are 
stored in the same private database that JasperReports Server uses to store the repository, but the data is only accessible 
through the audit Domains.

Auditing

A feature of JasperReports Server Enterprise edition that records all server activity and allows administrators to view the data.
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Calculated Field

In a Domain, a field whose value is calculated from a user-written formula that may include any number of fields, operators, 
and constants. A calculated field is defined in the Domain Designer, and it becomes one of the items to which the Domain’s 
security file and locale bundles can apply.

CRM

Customer Relationship Management. The practice of managing every facet of a company’s interactions with its clientele. 
CRM applications help businesses track and support their customers.

CrossJoin

An MDX function that combines two or more dimensions into a single axis (column or row).

Cube

The basis of most analysis applications, a cube is a data structure that contains three or more dimensions that categorize the 
cube’s quantitative data. When you navigate the data displayed in an analysis view, you are exploring a cube.

Custom Field

In the Ad Hoc Editor, a field that is created through menu items as a simple function of one or two available fields, including 
other custom fields. When a custom field becomes too complex or needs to be used in many reports, it is best to define it as a 
calculated field in a Domain.

Dashboard

A collection of reports, input controls, graphics, labels, and web content displayed in a single, integrated view. Dashboards 
often present a high level view of your data, but input controls can parameterize the data to display. For example, you can 
narrow down the data to a specific date range. Embedded web content, such as other web-based applications or maps, make 
dashboards more interactive and functional.

Derived Table

In a Domain, a derived table is defined by an additional query whose result becomes another set of items available in the 
Domain. For example, with a JDBC data source, you can write an SQL query that includes complex functions for selecting 
data. You can use the items in a derived table for other operations on the Domain, such as joining tables, defining a calculated 
field, or filtering. The items in a derived table can also be referenced in the Domain’s security file and locale bundles.

Data Policy

In JasperReports Server, a setting that determines how the server processes and caches data used by Ad Hoc reports. Select 
your data policies by clicking Manage > Ad Hoc Settings.

Data Source

Defines the connection properties that JasperReports Server needs to access data. The server transmits queries to data sources 
and obtains datasets in return for use in filling reports and previewing Ad Hoc reports. JasperReports Server supports JDBC, 
JNDI, and Bean data sources; custom data sources can be defined as well.

Dataset

A collection of data arranged in columns and rows. Datasets are equivalent to relational results sets and the JRDataSource 
type in the JasperReports Library.

Datatype

In JasperReports Server, a datatype is used to characterize a value entered through an input control. A datatype must be of type 
text, number, date, or date-time. It can include constraints on the value of the input, for example maximum and minimum 
values. As such, a datatype in JasperReports Server is more structured than a datatype in most programming languages.

Denormalize

A process for creating table joins that speeds up data retrieval at the cost of having duplicate row values between some 
columns.
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Dice

An OLAP operation to select columns.

Dimension

A categorization of the data in a cube. For example, a cube that stores data about sales figures might include dimensions such 
as time, product, region, and customer’s industry.

Domain

A virtual view of a data source that presents the data in business terms, allows for localization, and provides data-level 
security. A Domain is not a view of the database in relational terms, but it implements the same functionality within 
JasperReports Server. The design of a Domain specifies tables in the database, join clauses, calculated fields, display names, 
and default properties, all of which define items and sets of items for creating Ad Hoc reports.

Domain Topic

A Topic that is created from a Domain by the Data Chooser. A Domain Topic is based on the data source and items in a 
Domain, but it allows further filtering, user input, and selection of items. Unlike a JRXML-based Topic, a Domain Topic can 
be edited in JasperReports Server by users with the appropriate permissions.

Drill

To click on an element of an analysis view to change the data that is displayed:

 Drill down. An OLAP operation that exposes more detailed information down the hierarchy levels by delving deeper into 
the hierarchy and updating the contents of the navigation table.

 Drill through. An OLAP operation that displays detailed transactional data for a given aggregate measure. Click a fact to 
open a new table beneath the main navigation table; the new table displays the low-level data that constitutes the data that 
was clicked.

 Drill up. An OLAP operation for returning the parent hierarchy level to view to summary information.

Eclipse

An open source Integrated Development Environment (IDE) for Java and other programming languages, such as C/C++.

ETL

Extract, Transform, Load. A process that retrieves data from transactional systems, and filters and aggregates the data to create 
a multidimensional database. Generally, ETL prepares the database that your reports will access. The Jaspersoft ETL product 
lets you define and schedule ETL processes. 

Fact

The specific value or aggregate value of a measure for a particular member of a dimension. Facts are typically numeric. 

Field

A field is equivalent to a column in the relational database model. Fields originate in the structure of the data source, but you 
may define calculated fields in a Domain or custom fields in the Ad Hoc Editor. Any type of field, along with its display name 
and default formatting properties, is called an item and may be used in the Ad Hoc Editor.

Frame

A dashboard element that displays reports or custom URLs. Frames can be mapped to input controls if their content can accept 
parameters.

Group

In a report, a group is a set of data rows that have an identical value in a designated field.

 In a table, the value appears in a header and footer around the rows of the group, while the other fields appear as columns.

 In a chart, the field chosen to define the group becomes the independent variable on the X axis, while the other fields of 
each group are used to compute the dependent value on the Y axis.

Hierarchy Level

In analysis, a member of a dimension containing a group of members.
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Input Control

A button, check box, drop-down list, text field, or calendar icon that allows users to enter a value when running a report or 
viewing a dashboard that accepts input parameters. For JRXML reports, input controls and their associated datatypes must be 
defined as repository objects and explicitly associated with the report. For Domain-based reports that prompt for filter values, 
the input controls are defined internally. When either type of report is used in a dashboard, its input controls are available to be 
added as special content.

iReport Designer

An open source tool for graphically designing reports that leverage all features of the JasperReports Library. The Jaspersoft 
iReport Designer lets you drag and drop fields, charts, and sub-reports into a canvas, and also define parameters or expressions 
for each object to create pixel-perfect reports. iReport Designer outputs the JRXML of the report or uploads it directly to 
JasperReports Server.

Item

When designing a Domain or creating a Topic based on a Domain, an item is the representation of a database field or a 
calculated field along with its display name and formatting properties defined in the Domain. Items can be grouped in sets and 
are available for use in the creation of Ad Hoc reports.

JasperReports Library

An embeddable, open source, Java API for generating a report, filling it with current data, drawing charts and tables, and 
exporting to any standard format (HTML, PDF, Excel, CSV, and others). JasperReports processes reports defined in JRXML, 
an open XML format that allows the report to contain expressions and logic to control report output based on run-time data.

JasperReports Server

A commercial open source, server-based application that calls the JasperReports library to generate and share reports securely. 
JasperReports Server authenticates users and lets them upload, run, view, schedule, and send reports from a web browser. 
Commercial versions provide metadata layers, interactive report and dashboard creation, and enterprise features such as 
organizations and auditing.

Jaspersoft ETL

A graphical tool for designing and implementing your data extraction, transforming, and loading (ETL) tasks. It provides 
hundreds of data source connectors to extract data from many relational and non-relational systems. Then, it schedules and 
performs data aggregation and integration into data marts or data warehouses that you use for reporting.

Jaspersoft OLAP

A relational OLAP server integrated into JasperReports Server that performs data analysis with MDX queries. The product 
includes query builders and visualization clients that help users explore and make sense of multidimensional data. Jaspersoft 
OLAP also supports XML/A connections to remote servers.

JavaBean

A reusable Java component that can be dropped into an application container to provide standard functionality.

JDBC

Java Database Connectivity. A standard interface that Java applications use to access databases.

JNDI

Java Naming and Directory Interface. A standard interface that Java applications use to access naming and directory services.

Join Tree

In Domains, a collection of joined tables from the actual data source. A join is the relational operation that associates the rows 
of one table with the rows of another table based on a common value in given field of each table. Only the fields in a same join 
tree or calculated from the fields in a same join tree may appear together in a report.

JPivot

An open source graphical user interface for OLAP operations. For more information, visit http://jpivot.sourceforge.net/.
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JRXML

An XML file format for saving and sharing reports created for the JasperReports Library and the applications that use it, such 
as iReport Designer and JasperReports Server. JRXML is an open format that uses the XML standard to define precisely all 
the structure and configuration of a report.

MDX

Multidimensional Expression Language. A language for querying multidimensional objects, such as OLAP (On Line 
Analytical Processing) cubes, and returning cube data for analytical processing. An MDX query is the query that determines 
the data displayed in an analysis view.

Measure

Depending on the context:

 In a report, a formula that calculates the values displayed in a table’s columns, a crosstab’s data values, or a chart’s 
dependent variable (such as the slices in a pie).

 In an analysis view, a formula that calculates the facts that constitute the quantitative data in a cube. 

Mondrian

A Java-based, open source multidimensional database application.

Mondrian Connection

An analysis client connection that consists of an analysis schema and a data source used to populate an analysis view.

Mondrian Schema Editor

An open source Eclipse plugin for creating Mondrian analysis schemas.

Mondrian XMLA Source

A server-side XMLA source definition of a remote client-side XML/A connection used to populate an analysis view using the 
XMLA standard.

MySQL

An open source relational database management system. For information, visit http://www.mysql.com/.

Navigation Table

The main table in an analysis view that displays measures and dimensions as columns and rows.

ODBO Connect

Jaspersoft ODBO Connect enables Microsoft Excel 2003 and 2007 Pivot Tables to work with Jaspersoft OLAP and other 
OLAP servers that support the XML/A protocol. After setting up the Jaspersoft ODBO data source, business analysts can use 
Excel Pivot Tables as a front-end for OLAP analysis.

OLAP

On Line Analytical Processing. Provides multidimensional views of data that help users analyze current and past performance 
and model future scenarios.

Organization

A set of users that share folders and resources in the repository. An organization has its own user accounts, roles, and root 
folder in the repository to securely isolate it from other organizations that may be hosted on the same instance of JasperReports 
Server.

Organization Admin

Also called the organization administrator. A user in an organization with the privileges to manage the organization’s user 
accounts and roles, repository permissions, and repository content. An organization admin can also create sub-organizations 
and mange all of their accounts, roles, and repository objects. The default organization admin in each organization is the 
jasperadmin account.
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Outlier

A fact that seems incongruous when compared to other member’s facts. For example, a very low sales figure or a very high 
number of helpdesk tickets. Such outliers may indicate a problem (or an important achievement) in your business. The 
analysis features of Jaspersoft OLAP excel at revealing outliers.

Parameter

Named values that are passed to the engine at report-filling time to control the data returned or the appearance and formatting 
of the report. A report parameter is defined by its name and type. In JasperReports Server, parameters can be mapped to input 
controls that users can interact with.

Pivot

To rotate a crosstab such that its row groups become column groups and its column groups become rows. In the Ad Hoc 

Editor, pivot a crosstab by clicking .

Pivot Table

A table with two physical dimensions (for example, X and Y axis) for organizing information containing more than two 
logical dimensions (for example, PRODUCT, CUSTOMER, TIME, and LOCATION), such that each physical dimension is 
capable of representing one or more logical dimensions, where the values described by the dimensions are aggregated using a 
function such as SUM. Pivot tables are used in Jaspersoft OLAP.

Properties

Settings associated with an object. The settings determine certain features of the object, such as its color and label. Properties 
are normally editable. In Java, properties can be set in files listing objects and their settings.

Repository 

The tree structure of folders that contain all saved reports, dashboards, analysis views, and resources. Users access the 
repository through the JasperReports Server web interface or through iReport. Applications can access the repository through 
the web service API. Administrators use the import and export utilities to back up the repository contents.

Resource

In JasperReports Server, anything residing in the repository, such as an image, file, font, data source, Topic, Domain, report 
element, saved report, report output, dashboard, or analysis view. Resources also include the folders in the repository. 
Administrators set user and role-based access permissions on repository resources to establish a security policy.

Role

A security feature of JasperReports Server. Administrators create named roles, assign them to user accounts, and then set 
access permissions to repository objects based on those roles. Certain roles also determine what functionality and menu 
options are displayed to users in the JasperReports Server interface.

Schema

A logical model that determines how data is stored. For example, the schema in a relational database is a description of the 
relationships between tables, views, and indexes. In Jaspersoft OLAP, an OLAP schema is the logical model of the data that 
appears in an analysis view; they are uploaded to the repository as resources. For Domains, schemas are represented in XML 
design files.

Schema Workbench

A graphical tool for easily designing OLAP schemas, data security schemas, and MDX queries. The resulting cube and query 
definitions can then be used in Jaspersoft OLAP to perform simple but powerful analysis of large quantities of multi-
dimensional data stored in standard RDBMS systems.

Set

In Domains and Domain Topics, a named collection of items grouped together for ease of use in the Ad Hoc Editor. A set can 
be based on the fields in a table or entirely defined by the Domain creator, but all items in a set must originate in the same join 
tree. The order of items in a set is preserved.
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Slice

An OLAP operation for filtering data rows.

SQL

Structured Query Language. A standard language used to access and manipulate data and schemas in a relational database.

System Admin

Also called the system administrator. A user who has unlimited access to manage all organizations, users, roles, repository 
permissions, and repository objects across the entire JasperReports Server instance. The system admin can create root-level 
organizations and manage all server settings. The default system admin is the superuser account.

Topic

A JRXML file created externally and uploaded to JasperReports Server as a basis for Ad Hoc reports. Topics are created by 
business analysts to specify a data source and a list of fields with which business users can create reports in the Ad Hoc Editor. 
Topics are stored in the Ad Hoc Components folder of the repository and displayed when a user launches the Ad Hoc Editor.

Transactional Data

Data that describe measurable aspects of an event, such as a retail transaction, relevant to your business. Transactional data are 
often stored in relational databases, with one row for each event and a table column or field for each measure.

User 

Depending on the context:

 A person who interacts with JasperReports Server through the web interface. There are generally three categories of users: 
administrators who install and configure JasperReports Server, database experts or business analysts who create data 
sources and Domains, and business users who create and view reports and dashboards. 

 A user account that has an ID and password to enforce authentication. Both people and API calls accessing the server 
must provide the ID and password of a valid user account. Roles are assigned to user accounts to determine access to 
objects in the repository.

WCF

Web Component Framework. A low-level GUI component of JPivot. For more information, see http://jpivot.sourceforge.net/
wcf/index.html.

Web Services

A SOAP (Simple Object Access Protocol) API that enables applications to access certain features of JasperReports Server. 
The features include repository, scheduling and user administration tasks.

XML

eXtensible Markup language. A standard for defining, transferring, and interpreting data for use across any number of XML-
enabled applications.

XML/A

XML for Analysis. An XML standard that uses Simple Object Access protocol (SOAP) to access remote data sources. For 
more information, see http://www.xmla.org/

XML/A Connection

A type of analysis client connection that consists of Simple Object Access Protocol (SOAP) definitions used to populate an 
analysis view.
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